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MAX1441 Evaluation System

General Description

The MAX1441 evaluation system (EV system) provides
a proven design to evaluate the MAX1441 capaci-
tive proximity and touch sensor. The EV system con-
sists of two PCBs. The MAX1441 evaluation kit (EV
kit) includes the typical application circuit and all
electronics for USB-to-JTAG communication between
the on-board device and the PC. The MAX1441TP
evaluation kit (TP EV kit) includes two touch pads.
The TP EV kit connects to the EV kit through 20-pin
right-angle connectors. The EV kit board connects to
either the factory-provided kit touch pads board, or
a custom user-supplied touch sensor. The EV sys-
tem also includes Windows XP®- or Windows Vista®-
compatible integrated development environment
(MAX-IDE) for the MAXQ® microcontroller core of the
device.

The EV kit comes with a MAX1441GUP/V+ installed.

Windows, Windows XP, and Windows Vista are registered
trademarks of Microsoft Corp.

MAXQ is a registered trademark of Maxim Integrated
Products, Inc.

MAXIN

Features

Wide 6V to 28V VBAT Supply Range

External Touch-Sense Pad Included

Adaptive Firmware Source Code Included

USB PC-to-JTAG Connection

USB Powered or Battery Powered

Compatible with the MAX-IDE Development Tool
Proven PCB Layout

* & & 6 6 o oo o

Fully Assembled and Tested

Ordering Information

PART TYPE

MAX1441EVSYS+ EV System

+Denotes lead(Pb)-free and RoHS compliant.

Component Lists

MAX1441 EV System

QTY DESCRIPTION
1 MAX1441 EV Kit
1 MAX1441TP EV Kit

Component Lists continued at end of data sheet.

Maxim Integrated Products 1

For pricing, delivery, and ordering information, please contact Maxim Direct at 1-888-629-4642,

or visit Maxim’s website at www.maxim-ic.com.
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Quick Start

Required Equipment

e MAX1441 EV kit

e 6V to 28V DC power supply (9V battery) or PC with an
available USB port

The EV kit is shipped from the factory configured
(through jumper settings) for battery operation. To oper-
ate the EV kit from a USB port, see the Configuring the
EV Kit for USB Interface section for jumper setting.

The device’s on-board ASIC is preloaded with firmware
that causes the on-board output LEDs (LEDOUT1 and
LEDOUT?2) to turn on when capacitance applied on the
input terminals is increased (e.g., by moving your hand
close to the touch pads).

Procedure
The EV kit is fully assembled and tested. Follow the steps
below to verify board operation:

1) Verify that jumper settings are consistent with the
default positions shown in Tables 1 and 2.

2) Apply a 6V to 28V power supply (or 9V battery) on
the EXT_VBAT and GND terminals on the board.

Channel-1 (PAD1) Nonadaptive to Environment

1) Slowly move your hand towards PAD1. LEDOUT1

turns on when your hand is about 1cm from the PAD1
touch pad.

2) Move your hand away from the touch pad. LEDOUT1
immediately turns off.

3) Move your hand away from PAD1 and then back.
LEDOUT1 turns on again.

Channel-2 (PAD2) Adaptive to Environment

1) Slowly move your hand towards PAD2. LEDOUT2

turns on when your hand is about 2cm from the PAD2
touch pad.

2) Move your hand away from the touch pad. LEDOUT2
immediately turns off.

3) Move your hand close to PAD2 again. Stop and keep
your hand stable when LEDOUT2 turns on. LEDOUT2
stays on for a few seconds and then turns off. During
this time, the device has monitored the capacitance
changes on its input terminal and adjusted its Wake-
Up Threshold register, AT2H. At the end of this
period, the value in the AT2H register is the same
level as a new capacitance-to-digital (C2D) conver-

sion and does not result in LEDOUT2 turning on
(i.e., the device has adapted to its environment).

4) Move your hand away from PAD2 and then back.
LEDOUT2 turns on again. Within the time you moved
your hand away from and then back to PAD2, the
device readjusted its Wake-up Threshold register
again, and your approaching hand causes a wake-up.

Note: The device is programmed to respond only to a
capacitance increase at its input terminals (in this case,
caused by your hand moving towards the touch pads).
The output LEDs do not remain on, or turn on again, if
your hand is steady at a fixed distance from the touch
pads. Users can implement a different turn-on/turn-off
logic more suitable for their applications.

Programming and Operating
Through the USB Interface

Required Equipment
e MAX1441 EV kit (USB cable included)

e User-supplied Windows XP, Windows Vista, or
Windows 7 PC with a spare USB port

Note: In the following sections, software-related items
are identified by bolding. Text in bold refers to items
directly from the EV kit software. Text in bold and under-
lined refers to items from the Windows operating system.

Note: Complete installation of the USB driver before
proceeding with installation of the MAX-IDE application.

Note: For programming and debugging of the device,
a change from battery-operated demo mode to USB-
powered mode is required. The USB port powers on the
evaluation board only after the USB driver is installed.
Therefore, all LEDs on the board remain off and there is
no response to the touch pads until the USB driver instal-
lation is complete and successful.

Installing the USB Driver

1) Visit www.maxim-ic.com/evkitsoftware to down-

load the latest version of the EV kit software, 1441Rxx.

ZIP. Save the EV kit software to a temporary folder
and uncompress the ZIP file.

2) Install the EV kit software and USB driver on your
computer by running the INSTALL.EXE program
inside the temporary folder. The program files are
copied to your PC and icons are created in the
Windows Start | Programs menu. During software
installation, some versions of Windows may show
a warning message indicating that this software
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MAX1441 Evaluation System

is from an unknown publisher. This is not an error
condition and it is safe to proceed with installation.
Administrator privileges are required to install the
USB device driver on Windows.

Set up the evaluation board for communicating
through the USB port. See the Configuring the EV Kit
for USB Interface section for jumper setting.

Connect the USB cable from the PC to the EV kit
pboard. A Windows message appears when con-
necting the EV kit board to the PC for the first time.
Each version of Windows has a slightly different mes-
sage. If you see a Windows message stating ready
to use, then proceed to the next step. Otherwise,
open the USB_Driver_Help_200.PDF document in
the Windows Start | Programs menu to verify that
the USB driver was installed successfully.

Open the device manager by opening the shortcut
icon in the Windows Start | Programs | Maxim
EVKIT Software | MAX1441 | Open Device Manager
menu. ldentify the COM number under the Ports
(COM&LPT) category for the just-installed USB
driver. Write down the COM number for later action
when installing and configuring the MAX-IDE.

At this point, the evaluation board should be
powered up, LEDO and LED120 should be lit, and
the on-board CPU should be executing the prepro-
grammed firmware.

Move your hand close to the PAD1 and PAD2
touch pads on the evaluation board. LEDOUT1 and
LEDOUT2, corresponding to the PAD1 and PAD2
touch pads, respectively, blink.

Installing the MAX-IDE Application

Normally this installation is launched automatically by
the EV kit software installer. Use this procedure in case
the MAX-IDE setup was cancelled or MAX-IDE was unin-
stalled.

1)

2)

Set up the evaluation board for communicating
through the USB port. See the Configuring the EV Kit
for USB Interface section for jumper setting.

Run SETUP.exe in the C:\Program Files\Maxim\
MAX1441\MAX-IDE\install folder to install MAX-IDE
application to your hard drive.

In the InstallShield dialogs that appear, select the
Typical installation, which installs all the necessary
files for application development for the device.
Throughout the installation process, accept the
defaults offered by the installation procedure.
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4)

Copy the device configuration file, MAX1441.cfg
from the C:\Program Files\Maxim\MAX1441\MAX-
IDE\Devices\MAXQ folder to the C:\Program Files\
MAX-IDE\Devices\MAXQ folder.

The MAX-IDE installation is now complete.

Opening and Working with

an Existing MAX-IDE Project File

Set up the EV kit for communicating through the USB

port. See the Configuring the EV Kit for USB Interface
section for jumper settings.

Launch MAX-IDE from the Start | All Programs
menu or run GenericlDE.exe directly from the
C:\Program Files\MAX-IDE directory (see Figure 1).

Select the MAXQ JTAG menu item (default) under
Device in the menu bar (if not already selected).

Select the Options menu item under Device in the
menu bar (see Figure 2).

a) Select the serial port corresponding to the
device’s USB driver (previously described in
Step 5 of the Installing the USB Driver section).

b) Type MAX1441.cfg in the Device Configuration
File edit box.

c) Type 75 in the Desired JTAG Clock Freq. (kHz)
edit box.

d) Press the OK button. The MAX-IDE opens the
specified COM port and establishes communica-
tion at the specified frequency (75kHz). MAX-IDE
is now configured for the EV kit application.

Click on Open Project in the Project tab and open
C:\Program Files\MAX1441\example\appcode\
appcode.pr;j.

Select the Message tab at the bottom to view status
messages on the MAX-IDE window.

Select the Make menu item under Debug in the
menu bar to assemble the code. Build Successful
appears in the Message window.

Select the Step Into menu item under Debug in the
menu bar.

a) The hex code generated in the previous step
is downloaded into the program memory of the
device, and progress status is displayed in the
MAX-IDE Message window. Loading the firm-
ware into the program memory is complete and
successful when Delay Complete is displayed.
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9) Select Debug | Run to start the execution of the firm-
ware just loaded into the device.

The device starts executing the firmware. Move your
hand towards the touch pads to see the device's
response indicated by turning on/off LEDOUT1 and

LEDOUT2, corresponding to touch pads PAD1 and
PAD2, respectively. Select Debug | Pause to stop
the execution and view the content of each register
(displayed on the right side) in the Register window.
Select Debug | Run to resume execution.

" MAX-IDE
File Project Edit Debug Device Compiler Window Help
DM || fBe || FCEE ™0 || WS

Figure 1. MAX-IDE Main Window

Select the serial port where the JTAG device is connected.

|COM4

oK |

Device Configuration File: IMA><1 441.cfg
Desired JTAG Clock Freq. (kHz) |75

=

Figure 2. MAX-IDE Device Options Window
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Figure 4. MAX-IDE Messages Tab
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Creating a New Project with MAX-IDE
Set up the EV kit for communicating through the USB
port. See the Configuring the EV Kit for USB Interface
section for jumper settings.

Launch MAX-IDE from the Start | All Programs
menu or run GenericlDE.exe directly from the
C:\Program Files\MAX-IDE directory.

Select the Options menu item under Device in the
menu bar and follow the same steps mentioned in
step 4 in the Opening and Working with an Existing
MAX-IDE Project File section.

Select the New Project menu item under Project in
the menu bar of the MAX-IDE program.

Select the Add Files... menu item under Project in
the menu bar and select an existing assembly file

(e.g., test.asm) in the C:\Program Files\Maxim\
MAX1441\example\appcode directory.

Double-click the just-added file name to open it in
the editor window. You can edit, debug, and run the
source code in the MAX-IDE window.

Select Window | Show | Registers to see the
contents of the device registers.

Select Window | Show | Memory to see the contents
of the device flash memory. Use the drop-down list to
switch between Program memory and Data memory
(see Figure 7).

Select Project | Save Project As and type in the
name for the newly created project.

> MAX-IDE
File Project Edit Debug Device Compiler Window Help

joeE|sse|FEEEIBTE0 ][R

Figure 5. MAX-IDE Main Window

MAXIN

sojenjeny

PV EXVIN



: MAX1441

Evaluates

MAX1441 Evaluation System

™ MAX-IDE
File Project Edit Debug Device Compiler Window Help

DeE|sae||FDEE®T GO

[P

Untitled Project I

File Location

Figure 6. MAX-IDE Untitled Project Window
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Operating the Device Using MAX-IDE
Start the MAX-IDE application, open a project, and run it.

To view changes or values in registers as instructions
are executed, add a break point. To add a break point,
click on the line number to the left of the instruction of
interest. A break point (denoted by a big red dot) on the
instruction causes the device to pause when the pro-
gram counter gets to the marked instruction (the device
pauses before the instruction is executed). When the
device is stopped, the latest contents of the registers
are displayed in the Register window. Then, use one
of the Debug | Step Into, Debug | Step Over, Debug
| Out, or Debug | Run to Cursor functions to get to a
different part of the program and see how the register
values change.

To change the content of a register to observe how
it affects the device operation, press Debug | Pause
(if not paused already), locate the desired register in the
Register window, delete the current content and type in
a new value, and then select Debug | Run. An example
of how this works follows.

Adjusting Touch-Detection Sensitivity

1)  Set up the EV kit for communicating through the

USB port. See the Configuring the EV Kit for USB
Interface section for jumper settings.

2)  Launch MAX-IDE and open appcode.prj.

3) Set the Device | Options, as shown in Figure 2.

4)  Select Debug | Run.

5) Move your hand towards the touch pads. The

output LEDs come on when your hand is about 2cm
from the touch pads.

6) Select Debug | Pause.

7)  Select System Registers from the Registers drop-
down list.

8) Locate the LC[0] and LC[1] registers.

9) Change the value in the LC[O] register from 0001 to
3. Press Enter.

10) Change the value in the LC[1] register from 0001 to
6. Press Enter.

11) Select Debug | Run.

12) Move your hand towards the PAD1 touch pad until
LEDOUT1 turns on. Observe that your hand must
get much closer to the touch pad for LEDOUT1 to
turn on.

13) Move your hand towards the PAD2 touch pad until
LEDOUT2 turns on. Observe that your hand must

10

get even closer than that for PAD1 for LEDOUT2 to
turn on.

It is also possible to change the touch sensitivity by
adjusting the Range register, CRNG. However, note
that reducing the detection range could result in C2D
register overflow and cause the output LEDs to persis-
tently remain on.

Note: Only LEDOUT1 and LEDOUT2 on the EV kit are
controlled by the device, indicating input capacitance
change on the SINPUT1 and SINPUT2 terminals. All
other LEDs on the board indicate the status of the JTAG
communication lines and other activities on the EV Kit.
See the EV kit circuit schematic for their function.

Configuring the EV Kit for USB Interface
The evaluation board is shipped from the factory with
jumper settings for battery operation. To program and
operate the board through the USB port, the jumpers
must be set as follows:

1) Disconnect the USB cable from the board (if
connected). Verify that jumper settings are consis-
tent with that of Tables 1 and 2 default positions.

2) Move the shunt of jumper JU4 to the 1-2 position to
power the device from the USB+5V supply.

3) Insert jumper JU125 so the device's VDD powers the
JTAG level translators.

_ Detailed Description of Hardware

The MAX1441 EV kit provides a proven layout for the
MAX1441. On-board USB-to-JTAG circuitry supports
custom firmware development.

U3 (MAX8511) is an on-board 3.3V regulator that
optionally powers the LED indicators.

The low-voltage 1/O pins (P0.0, P0O.1, P0.2, and PO0.4)
optionally connect to LED indicators LEDO-LEDS.
In addition, P0.4 can be used to sense pushbutton
switch SW3. The high-voltage 1/O pins (P0.5/0UT1 and
P0.6/OUT2) optionally connect to LED indicators
LEDOUT1 and LEDOUT2 to indicate a capacitance
change on the input terminals.

The U10-U15 components are USB-interfaced JTAG
controller circuits, which are equivalent to the MAXQ2000
EV kit's JTAG controller board (MAXQJTAG-001B).
Jumpers JU120-JU125 connect U10-U15 to the JTAG
port of the MAX1441 (U1). Port I/O pins P0.0-P0.3 are
used for JTAG.
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Table 1. Jumper Descriptions (JU1, JU2, JU4-JU7, JU12-JU16, JU19, JU20, JU21)

JUMPER SIGNAL SHUNT POSITION DESCRIPTION
JUT VDD Not installed” Powers VDD from the on-chip 3.4V VAA LDO.
PCB trace cut open Powers VDD from an external supply.
Not installed” Normal operation.
Ju2 VBAT ing i
PCB trace cut open Measure supplylcurre.nt uslmg jumper JU2'. Cut the PQB trace and place
a current meter in series with the two terminals of the jumper.
1-2 Powers VBAT from the USB+5V bus power.
Ju4 VBAT ot Powers VBAT from an external user-supplied power. JU125 must be
open.
1-2* +3.3V (U3) powers the reconstruction DAC (U7).
Jus DAC_VDD .
Open External power must drive the DAC VDD.
1-2 PO.0/INTO/TCK drives the reconstruction DAC SCL.
JU6 DAC_SCL [INTOTTCK drives —
Open* Reconstruction DAC is not used.
U7 DAC.SDA 1-2 PO.1/INT1/TPO oIrives' the reconstruction DAC SDA.
Open* Reconstruction DAC is not used.
1-2* Powers port 0 LEDs from VDD.
Ju12 ledpwrA
2-3 Powers port O LEDs from +3.3V (U3).
1-2* PO.0/INTO/TCK drives LEDO.
Ju13 P0.0 LED ,
2-3 PO.0/INTO/TCK is pulled up by 10kQ (R38).
1-2* P0.1/INT1/TDO drives LED1.
Jui4 P0.1 LED :
2-3 P0.1/INT1/TDO is pulled up by 10kQ (R39).
1-2* P0.2/INT3/TDI drives LED2.
Jui5 P0.2 LED -
2-3 P0.2/INT3/TDI is pulled up by 10kQ (R40).
1-2* P0.4 drives LEDS.
Ju16 P0.4 LED -
2-3 P0.4 is pulled up by 10kQ (R41).
1-2* P0.5/0OUT1 drives LEDOUT1.
Ju19 P0.5 LED -
2-3 P0.5/0UT1 is pulled up by 10kQ (R16).
1-2* P0.6/OUT2 drives LEDOUT2.
Ju20 P0.6 LED -
2-3 P0.6/0UT2 is pulled up by 10kQ (R17).
1-2% Powers LEDOUT_ from VBAT.
Ju21 ledpwrH
2-3 Powers LEDOUT_ from +3.3V (U3).

*Default position.

MAXIM i
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Table 2. Jumper Descriptions for JTAG (JU100-JU109 and JU120-JU125)

SHUNT
JUMPER SIGNAL POSITION DESCRIPTION
1-2* Normal MAXQJTAG-001B-equivalent JTAG host. USB bridge chip 1/O is at 5V.
JU100 USB_VDDIO - - , . -
2-3 FT232 JTAG bit-banging JTAG host. USB bridge chip 1/O is at 3.3V.
Not installed* Normal MAXQJTAG-001B-equivalent JTAG host.
JU101 USB_TXD
- PCBrace cut | croa5 JTAG bit-banging JTAG host.
open
Not installed* Normal MAXQJTAG-001B-equivalent JTAG host.
Ju102 USB_RXD
- PCB race cut | troa5 JTAG bit-banging JTAG host.
open
Open* Normal MAXQJTAG-001B-equivalent JTAG host.
JU103 | USB_RTS & QITAG001B-equiv
1-2 FT232 JTAG bit-banging JTAG host.
JUu104 USB_CTS Open* Normal operation.
1-2 Reserved.
JU105 USB_DTR -
2-3* Normal MAXQJTAG-001B-equivalent JTAG host.
JU106 USB_DSR Open” Normal MAXQ\'JTAG-0.01B-equivaIent JTAG host.
1-2 FT232 JTAG bit-banging JTAG host.
Open” Normal MAXQJTAG-001B-equivalent JTAG host.
Jui1o7 USB_DCD - -
1-2 FT232 JTAG bit-banging JTAG host.
Open* Normal MAXQJTAG-001B-equivalent JTAG host.
Ju108 USB_RI X -
1-2 FT232 JTAG bit-banging JTAG host.
JU109 JTAG HV Open* Normal operation.
PWR 1-2 Connects USB+5V to JTAG pin 8 to provide power to the JTAG host.
JU120 TCK 1-2¢ Normal MAXQJTAG-001B-equivalent JTAG host.
Open External JTAG host or FT232 JTAG bit-banging JTAG host.
JU121 00 1-2* Normal MAXQJTAG-001B-equivalent JTAG host.
Open External JTAG host or FT232 JTAG bit-banging JTAG host.
JU122 - 1-2* Normal MAXQJTAG-001B-equivalent JTAG host.
Open External JTAG host or FT232 JTAG bit-banging JTAG host.
JU123 ™S 1-2* Normal MAXQJTAG-001B-equivalent JTAG host.
Open External JTAG host or FT232 JTAG bit-banging JTAG host.
I 1-2% Normal MAXQJTAG-001B-equivalent JTAG host.
Jui24 U1 RESET , .
Open External JTAG host or FT232 JTAG bit-banging JTAG host.
1-2 Normal MAXQJTAG-001B-equivalent JTAG host.
Ju125 JTAG VDD . .
Open* External JTAG host or FT232 JTAG bit-banging JTAG host.

*Default position.
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Jumper Settings for

MAXQJTAG-001B (Normal Defaults)

The normal default configuration connects an on-board

MAXQJTAG-001B-equivalent JTAG host to the device.

A virtual communications port (VCP) device driver

connects the FT232 USB bridge chip to the DS89C450-

ENL+, which runs the JTAG host firmware. This JTAG

host can be driven by Maxim’s MAX-IDE integrated
development environment.

Jumper Settings for External JTAG Host
To connect the EV kit to an external user-supplied
JTAG interface, disconnecting the on-board JTAG host,
remove the shunts from jumpers JU120-JU125, and
move the shunt on jumper JU105 to the 2-3 position.
Install header pins at JTAGU1 and connect your JTAG
host.

Table 3. Default Jumper Settings for MAXQJTAG-001B (JU100-JU108 and

JU120-JU125)

JUMPER SIGNAL DEFAULT SHUNT POSITION DESCRIPTION
Normal MAXQJTAG-001B-equivalent JTAG host.
JU100 USB_VDDIO 1-2 USB bridge chip 1/O is at 5\?
JU101 USB_TXD (shortzgttl)r;slt:’a(!;dtrace) Normal MAXQJTAG-001B-equivalent JTAG host.
Ju102 USB_RXD (Shorggt t')';sﬂgdtrace) Normal MAXQJTAG-001B-equivalent JTAG host.
Ju103 USB_RTS Open Normal MAXQJTAG-001B-equivalent JTAG host.
Ju104 USB_CTS Open Normal operation.
JU105 USB_DTR 2-3 Normal MAXQJTAG-001B-equivalent JTAG host.
Ju106 USB_DSR Open Normal MAXQJTAG-001B-equivalent JTAG host.
Juio7 USB_DCD Open Normal MAXQJTAG-001B-equivalent JTAG host.
Ju1os USB_RI Open Normal MAXQJTAG-001B-equivalent JTAG host.
Ju120 TCK 1-2 Normal MAXQJTAG-001B-equivalent JTAG host.
Jui21 TDO 1-2 Normal MAXQJTAG-001B-equivalent JTAG host.
Jui122 TDI 1-2 Normal MAXQJTAG-001B-equivalent JTAG host.
Ju123 T™MS 1-2 Normal MAXQJTAG-001B-equivalent JTAG host.
Jui24 U1 RESET 1-2 Normal MAXQJTAG-001B-equivalent JTAG host.
JU125 JTAG VDD 1-2 Normal MAXQJTAG-001B-equivalent JTAG host.

Table 4. JTAGU1 Header (JTAGU1-1-JTAGU1-10)

PIN NAME FUNCTION
JTAGU1-1 PO.O/INTO/TCK | Port O, bit O digital input/output with configurable edge/level-triggered interrupt (TCK).
JTAGU1-2 GND Ground.
JTAGU1-3 PO 1/INT1/TDO (F;Io:’rbop,obritt& (;ii?iée_ll input/output with configurable edge/level-triggered interrupt (TDO);
JTAGU1-4 VDD Digital power-supply input.
JTAGU1-5 P0.3/TMS Port 0, bit 3 digital input/output (TMS); CPU port, bit 3.
JTAGU1-6 U1 RESET U1 active-low reset input.
JTAGU1-7 N/C No connection; PCB not drilled.
JTAGU1-8 USB+5V +5V supply from the USB terminal.
JTAGU1-9 P0.2/TDI Port 0, bit 2 digital input/output with configurable edge/level-triggered interrupt (TDI).
JTAGU1-10 GND Ground.
MAXIMN 1
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Y=  Table 5. Jumper Settings for External JTAG Host (JU103, JU105-JU109 and
JU120-JU125)

: MAX144

Evaluates

JUMPER SIGNAL SHUNT POSITION DESCRIPTION

JU103 USB_RTS Open* Normal MAXQJTAG-001B-equivalent JTAG host.

EV kit factory test: Enable loading DS89C450 firmware into
JU105 USB_DTR 23 MAXQJTAG—yOO1 B-equivalent JTAqG host.
JU106 USB_DSR Open* Normal MAXQJTAG-001B-equivalent JTAG host.
Ju107 USB_DCD Open* Normal MAXQJTAG-001B-equivalent JTAG host.
Ju108 USB_RI Open* Normal MAXQJTAG-001B-equivalent JTAG host.

Open* Normal operation.
JU109 JTAG HV PWR - -
1-2 Connect USB+5V to JTAG pin 8 to provide power to JTAG host.

Ju120 TCK Open External JTAG host or FT232 JTAG bit-banging JTAG host.
Jui21 TDO Open External JTAG host or FT232 JTAG bit-banging JTAG host.
Jui22 TDI Open External JTAG host or FT232 JTAG bit-banging JTAG host.
Ju123 ™S Open External JTAG host or FT232 JTAG bit-banging JTAG host.
Jui24 U1 RESET Open External JTAG host or FT232 JTAG bit-banging JTAG host.
JU125 JTAG VDD Open External JTAG host or FT232 JTAG bit-banging JTAG host.

*Default position.

Table 6. Jumper Descriptions for Touch Pads (H5 and H6)

JUMPER SIGNAL SHUNT POSITION DESCRIPTION
1,35 Top guard ring for PAD2.
2 AGND.
H5 SINPUT2 4 AGUD2 pin of the device and guard plate on back side of PAD2.
6 SINPUT2 pin of device and touch pad PAD2.
3-4* Top guard ring connected to AGUD2.
1,35 Top guard ring for PAD1.
2 AGND.
H6 SINPUT1 4 AGUD1 pin of the device and guard plate on back side of PAD1.
6 SINPUT1 pin of the device and touch pad PAD1.
3-4* Top guard ring connected to AGUD1.

*Default position.
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Component Lists (continued)

MAX1441 EV Kit

DESIGNATION QTY DESCRIPTION DESIGNATION QTY DESCRIPTION
0.474F +10%, 100V X7R JU1, Ju2, Ju1of, Not installed, 2-pin headers—
C1,C2,C13 3 ceramic capacitors (0805) JU102 0 shorted with PCB trace
Murata GRM21BR72A474K
Not installed, ceramic capacitor Ju4, Ju12-Ju1ie,
C3 0 4 .
(1210) JU19, Ju20, Ju21,| 11 | 3-pin headers
1uF +10%, 16V X5R ceramic Ju100, JU105
C10, C108 2 capacitors (0603) JUS, JUB, JU7,
TDK C1608X5R1C 105K JU103, JU104,
10pF £20%, 16V X5R ceramic Ju106, Ju107, 15 | 2-pin headers
C11, C109 2 | capacitors (1206) Ju108, JU109,
Murata GRM31CR61C106M JU120-JU125
10uF £20%, 50V X7S ceramic L101 ’ Ferrite bead (0603)
C12 1 capacitor (1210) TDK MMZ1608R301A
Taiyo Yuden UMK325BJ106MM LEDO-LED3,
C100-C105, C111, 0.1uF '110%, 16V X7R ceramic LEDOUTA1, 7 Red LEDs (0805)
C121, C131, 11 capacitors (0603) LEDOUT2,
C141, C151 Murata GRM188R71C104K LED120
22pF +5%, 50V COG ceramic p-channel FET (SOT223)
' Q100 1 o
C106, %‘1%73 C1220 4 | capacitors (0603) Fairchild NDT456P
TDK C1608C0G1H220J n-channel FET (SOT23)
Q142 1 .
33000pF +10%, 25V X7R Central Semi 2N7002
C110 1 ceramic capacitor (0603) RO, R12 2 0Q +5% resistors (0603)
Murata GRM188R71E333K R9 1 | 4.7kQ +5% resistor (0603)
47pF +5%, 50V COG ceramic R14, R15 510Q +£5% resistors (0603)
C142 1 capacitor (0603) R16, R17, R112, o )
Murata GRM1885C1H470J R122, R131, R142| © | 10K 5% resistors (0603)
1A, 50V diode (DO41) R32-R35 4 160Q £5% resistors (0603)
D1 1 . i
Diodes Inc. 1N4001 R38-R41 4 10kQ +5% resistors (0402)
1A, 40V Schottky diode R54 1 200Q +5% resistor (0603)
D2 1 (SOD123) R100, R152 2 1kQ +£5% resistors (0603)
Diodes Inc. TN5819HW-7-F R101, R102 2 | 27Q +5% resistors (0603)
H1, H2 0 Not installed, 10-pin headers R103 1 1.5kQ +5% resistor (0603)
H3 1 3-pin header R104 1 470Q +5% resistor (0603)
- ight- R111 1 2.2kQ +5% resistor (0603
INPUTH, INPUT2 o | Dual-row (2 x 8) right-angle * | ( )
receptacles R121 1 1.1kQ +£5% resistor (0603)
J10 ’ USB type-B right-angle female R123 1 820Q +5% resistor (0603)
receptacle R151 1 3.3kQ +5% resistor (0603)
JTAGU1 1 10-pin (2 x 5) header SW7, SW122 2 Momentary NO switches
MAXIMN 5
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Component Lists (continued)

MAX1441 EV Kit (continued)

DESIGNATION QTY DESCRIPTION DESIGNATION QTY DESCRIPTION
TPO_TP4 0 Nolt installed, multipurpose test Quad buffer, three-state IC
points U3 1 (14 SO)
. . Fairchild 74AC125SC

Automotive two-channel proxim-

U1 ’ ity and touch sensor CMOS analog mux/switch
(20 TSSOP) ui4 1 (16 TSSOP-EP*)
Maxim MAX1441GUP/V+ Maxim MAX4619EUE+
Ultra-low-noise, high-PSRR, Single-supply comparator
120mA, 3.3V LDO linear U15 ’ (5 SOT23)

u3 1 regulator (5 SC70) Maxim MAX9140EUK+
Maxim MAX8511EXK33+ (Top Mark: ADQP)
(Top Mark: AEI) 6MHz crystal
12-bit, low-power, 2-wire, serial Y10 1 Hong Kong X'tals

U7 ’ voltage-output DAC (6 SOT23) SSLB000000E18FAF
Maxim MAX5812LEUT+ 7.3728MHz Crystal
(Top Mark: AAYT) Y12 1 Hong Kong X'tals

U10 ’ UART-to-USB converter SSL73728NSMI028X1-0
(32 TQFP) — 18 | Shunts
Not installed, 93C46-type 3-wire o ’ USB high-speed A-to-B

U1 0 EEPROM 16-bit architecture cables, 6ft
(8 SO) o 1 PCB: MAX1441 EVALUATION
Ultra-high-speed flash KIT+

ut2 1 microcontroller (44 TQFP) *EP = Exposed pad.

Maxim DS89C450-ENL+

16

/V denotes an automotive qualified part.

MAX1441TP EV Kit
DESIGNATION QTyY DESCRIPTION
Not installed, 6-pin headers
HS5, He 0 (2 x 3)—shorted with PCB trace
INPUT1, INPUT2 5 Dual-row (2 x 8) right-angle

headers

PCB: MAX1441 TOUCH PADS+
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Component Suppliers

SUPPLIER PHONE WEBSITE
Central Semiconductor Corp. 631-435-1110 www.centralsemi.com
Diodes Incorporated 805-446-4800 www.diodes.com
Fairchild Semiconductor 888-522-5372 www.fairchildsemi.com
Hong Kong X'tals Ltd. 852-35112388 www.hongkongcrystal.com
Murata Electronics North America, Inc. 770-436-1300 www.murata-northamerica.com
Taiyo Yuden 800-348-2496 www.t-yuden.com
TDK Corp. 847-803-6100 www.component.tdk.com

Note: Indicate that you are using the MAX1441 when contacting these component suppliers.

MAX1441 EV Kit Files

FILE DESCRIPTION
INSTALL.EXE Installs the EV kit files on your computer.
usb_driver Folder containing USB device driver files.
usb_drivenUSB_Driver_Help_200.PDF USB driver installation help file.
MAX-IDE\instalNSETUP.EXE Setup file for the MAX-IDE development tool for the MAXQ microcontroller core.

Configuration file for the device. Copy into the

MAX-IDE\DevicesMAXQIMAXT441.C1g | py 0o Files\WMAX-IDE\Devices\WIAXQ” folder after installing MAX-IDE application.

example\appcode\WAX1441.inc Register definition include file for the device.
example\appcode\maxqg_sfr1.def System register definition include file for the device.
example\appcode\Appcode.asm Example firmware source code for the EV kit firmware.
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Figure 8a. MAX1441 EV Kit Schematic (Sheet 1 of 6)
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Figure 8e. MAX1441 EV Kit Schematic (Sheet 5 of 6)
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Figure 8f. MAX1441 EV Kit Schematic (Sheet 6 of 6)
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